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‘ House Keeping

= 201 - Interacting with Relational Databases
— Tuesday 11:00 am - 12:30 pm
— Chris Judd
= 501 - Developing Enterprise JavaBeans with
J2EE Standard Tools
— Wednesday 9:15 am - 10:45 am
— Chris Judd
= 701 - Building with the Data Tools Project
- Wednesday 2:00 pm - 3:30 pm
— Der-Ping Chou and John Graham
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‘ House Keeping

= 204 - Developing Web Services with Eclipse
— Tuesday 11:00 am - 12:30 pm
— Arthur Ryman

= 404 - Developing Web Services with the
Web Tools Platform
— Tuesday 3:30 pm - 5:00 pm
— David Gallardo

* 502 - 602 — Web Application Development
with Web Tools Platform
- Wednesday 9:15 am - 10:45 am & 11:00 am —

12:30 pm

— Tim Wagner
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‘ Agenda

« WTP Overview
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‘ Web Tools Platform Project (WTP)

Top Level Eclipse Project
www.eclipse.com/webtools/
Development tools for web development
— No runtime dependencies

— Vendor extensible

Subprojects

- Web Standard Tools (WST)

— J2EE Standard Tools (JST)
Version 0.7 was released August 2, 2005.
Dependencies

— Eclipse 3.1

— Eclipse Modeling Framework (EMF) 2.1.0

— Graphic Editor Framework (GEF) 3.1

- Java EMF Model (JEM) 1.1
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‘ WTP Subprojects

= Web Standard Tools (WST)

— Web artifacts

— Defined by open standards bodies
= J2EE Standard Tools (JST)

— J2EE components

— Java Community Process (JSP)

— Depends on WST

= JavaServer Faces Tools (JSF)
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‘ WTP Scope

Struts =L
JCA
Geronimo ITA ASP.NET
Velocity
JDBC Metadata
Tapestry VB Script
J5F
J2EE 1.4
Hibernate
ColdFusion
Spring Tomcat
XDoclet EIRB 118
XHLC J0nAS
ms VG
018 Servlet )
JavaScript
WebWorks
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‘ WTP Web Services Scope

World Wide Web Consortium (W3C)

- http://www.w3.0rg

— HTML, XHTML, CSS, XML, XSLT, XML Schema, XML Query
Organizations for Advancement of Structured
Information Standards (OASIS)

- http://www.oasis-open.org

— e-Business standards for web services
Web Services Interoperability Organizations (WS-I)
- http://www.ws-i.org

— Interoperable message exchange between web services
Java Community Process (JCP)

- http://www.jcp.org

— Java Web Services APIs
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‘ WTP Installation Options
e All-in-one
— Eclipse 3.1

— Eclipse Modeling Framework (EMF) 2.1.0
— Graphic Editor Framework (GEF) 3.1
- Java EMF Model (JEM) 1.1
= Update Manager
— Eclipse.org update site
= Piecemeal
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‘ Agenda

« \Web Services Overview
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‘ Simple Object Access Protocol

From the draft W3C specification:

SOAP is a lightweight protocol for exchange of
information in a decentralized, distributed
environment. It is an XML based protocol that
consists of three parts: an envelope that defines a
framework for describing what is in a message and
how to process it, a set of encoding rules for
expressing instances of application-defined
datatypes, and a convention for representing
remote procedure calls and responses.

http://www.w3.orqg/TR/soap/
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‘ WSDL

= Web Service Definition Language

« Describes
— What the service can do
— Where it resides
— How to invoke it

= Elements
— Types — data type definition
— Message - definition of data being communicated
— Port Type — abstract set of operations
— Binding - concrete protocol and data format
— Service - collection of related endpoints
— Port - binding and a network address
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‘ Apache Axis

= Apache Web Services Project
= Open Source

= SOAP implementation

e Version 1.2.1

= http://ws.apache.org/axis/
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‘ Agenda

= Producing Web Services (bottom up)
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‘ Producing Web Services

= Bottom up
- Start with Java code
— Generate WSDL
e Top down
— Start with WSDL
— Generate Java code
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‘ Bottom Up Steps

Create Dynamic Web Project
Create JavaBeans

Create Service

Generate Web Service

hwbhE

© 2004 Judd Solutions, LLC. All rights reserved.

Judd Solutions

‘ Create Dynamic Web Project

= File > New > Other > Dynamic Web Project

_ New Dynami Web Project x|
Dynamic Web Project
B | crua s mansuins omamc et proector ad e a newar wsmng Q@
Flexible Project Enterprise Application.

Creste & fledble project.

Moduie Name: | v

Project: |order =]

Name: [ Creles] Target server: [ Apache Tomcat v5.0
Project location: [ C\deviworkspaces\ew2o0s Browse...|

IHde.v\dvamed <=
Show Advanced > = I

Moduie Version: [2.4 =]
Target server: |Aun(ht Tomcat v5.0 d NEW... [~ Add module to an EAR appication.

or: [ |
Context Root: | ws
I™ Add support for annotated Java casses
e

cpock | o | mosh | conen |
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Create JavaBeans

= Data Transfer Objects
— Purchase Order
- Lineltem
— Address N g g diigaing e

@ getAddress()

o setaddress{String)
& getCey()

o setCiy(String)

w  getNarme()

= & PurchaseCrder & sathame{string)
@ PurchaseOrden(String, Address, Address, Lneltem(]) w  geiState()
® getBiTof) @ setSrate(String)
@ setBTo(Address) @ getZipCode)

e getld]) & setTpCode(Sring)
o satid{String)

e getlterns()

& ssthems{Uneltem[])
@ getshipTol) =@ LUneftem
&  setShipTo(address) ®"

® getPrice()

o setPrice(BigDecmal)
e getQuantity()

@ satQuantiy(int)
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Create Service

public class Order {

private static final float DISCOUNT =
0.9f;

public float quote(float price, int
quantity) {
if (quantity > 100) {
price = price * DISCOUNT;
by

return price * quantity;

= 0 Order
} o quote(fioat, int)
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Generate Web Service

< New > File > Other > Web Services > Web
Service

= Right click > Web Services > Create Web

Services El

Web Services
Kivawss v Vish sarate otons and make sy necessary chasges belcrs pricesdes B B rae page

Servce
Wb serviee type: [Bottom up Seen e Wt Servce =]
¥ Start Wk service i W progect

™ aunch the web

[¥ Gererate & proxy
Clent prosy
Chent proscy ype: [Sava Provy =

[+ Test the Web service:

T~ Monkor the Web srvce

1% Cverurie e withont warmng
¥ Creste foders mhen necessary
T Cowck out fles without warming

™ D0 ok show me B dikog box agan.

[ |
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Generate Web Service

A
Service Deployment Configuration
Chaasin o tha o Furtisaes s Seplyment saren, 6 e Bt deliult semngs
project and the EARL project aocated
an EAor not exst
amsocatee) 25 required when you cick Next,
Sever-Side Deployment Selecton:
Vb service runtime: Agache Axs.
Server Tomeat v Server  ncahon
SELRE, 2EE werson: 14
Webs servcn type: [bottom up Sevn bewn Web Serve =l v
= Start Web service i Wb project Service propec: | coder =]
T Lauch the web srcemosde [ |
[+ Gerwrate & prowy Servie EAR project: | =]
et prosy Service EAR moduie: | |
et proscy Byp: [ ava Proy =
Chent-Sicie Enveonment Selecton:
[+ Test the Wb senvice e service runtime: Apache Axs.
™ Monkos the Web servee. Server: Tomcat v5.0 Server § incahost
= Overwete fles wehout verrng 128 e 14
¥ Create lotders when recessary |
T ok out fies wthout waming Dl type: [wes =l
™ Do pot show me s hkog b agan. e e =l
Chent meduie: | weeciens =
Clert AR progect | =]
Cherit EAR moduie: -
I | I ¥
<pock [Taemr | pen | cenl |
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Generate Web Service

£

Serve

Web Service Java Bean Identity
vieb

WSO foider: | iy 200G/ Onder fwiy Wet:Contert
WSDL Fle: | e vt
Methods.

[ ctrifcat e}

Seiect M| Dessiect M
™ Document Lt (Wiagped)

1" Document) Lteral
& RPCS Encodied

1™ Defie cuseom mappeg for package b namespace.

e e | v |

Cancel

Web Service Test Page

Swlect o bast facilty

- Wah Service

Test facity [web Services Expiorer

- ek I lisaa > I Einish,
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Generate Web Service

- Wah Service

Web Service Proxy Page

(e

[ Forderica

Wb Servcs Praxy Page a

™ Define custom mapping for namespace to package.

eme [Thea> || peen | sl

- Wah Service

Web Service Client Test

Do you wink 1o best the genensbed progy?

[¥" Test the generated proxy

Testfacky [web service sampie 15Ps

[=|
5 progects [ T =l
EAR projects | [
Foidar: | sampieCrerProxy

setErdpontjava.lng. Strng)
[F getordery
[F] ctefioat o)
SQHINI Deselect Al

[+ Run test on server

- fjack [ Einish
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‘ Generate Web Service

x|
Web Service Publication
Do you want 1o publish your Web servce?

[ Launch the Web Services Explorer to publsh this Web service to the Unit Test UDDI Registry
[~ Launch the Web Services Explorer to publsh this Web service to a UDDT Regitry
Publc VDD Registry [[E8 LDDT Test Reastry &

e o |
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‘ Agenda

< WTP Overview

= Web Services Overview

= Producing Web Services (bottom up)
= Testing

e Consuming

= Conclusion
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‘ Test Client

e http://localhost:8080/orderWSClient/sample
OrderProxy/TestClient.jsp?endpoint=http://|
ocalhost:8209/orderWS/services/Order

=lgix
Fe Bt Vew Foote oo Hep »
Qe ~ - =] (2] (1| sewch vt e £ 5 L M "
! flocaihont: S0B0 o der v S Tent ot i eetprant st || Wl ansstant =
ks s ooy e R e et ] J0ocicom ] wheneer i
Cogler[ w] Csaweh | 9™ & 2 popus chay | Ok + 4 hetolink =+
Methods “Inputs B
» getEndpoint e
i} quanin: 8
imvoke | Caoar |
|
Result -
6.0
= =
gl one &
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‘ TCP/IP Monitoring

= View SOAP request and response

Problems | Javodoc Dedaration| Console | Snippets| Properbes | Servers fIRTeT AT IR BE[A~=0
= & bbcahost:8209 Time of request: 5:22.10.596 Ak
I /o' s/ Oircder Response Time: 831 ms
Type: HTTP
sw.mumq;f:q [eyee El Sie: 463 (603) bytes Byte |

Header: POST forderWS/services/Order HTTR/1.0 Header: HTTP/1.1 200 OK
<?xml version="1.0" encoding="UTF 8" 2> 4[<2xml veraion="1.0" encoding="utf 8" 2> ]

o1 o of?
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‘ Web Service Explorer Testing

= Test any Web Services

Fe B Vew Fovortes Tooh Hep

O -

Congew =] Search v 9™ 5 S pepugn sy | F Cherk = 4 Look lor Map

w] 2 | s Cormots Wl &) L M @3
pesepiore frexTiores Mo eckne wit . expiorer () =] et mantaer
g _ipe itows _web ] )0ocucom ] ¥Peener g Groovy Detugger  XDocet

Foptom &

Wik Servees Explorer
= Navgato #| hcxorn

% tnvalor 3 WSIN. Operation

o

repprm——|

fr—
Ochne RQFHIXS 1w/ eWwSfunWbeLSa 7
4 srrg

Frlines Wkl

1 Smom

ey

= DrectoryCategory

| [ AT

Erter the parameters.of tha WSEL operation and dck G b rvoke.

TulvewabieName (szmg]: Top/AtuMuic/Concerts_a
|

et EertnFeans sk ekt _,j

- o et
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= Graphically edit WSDL

Definition
Imports Types
SErvices Bindings Paort Types
Bl & Orderservice B Ordersoapinding B 0 Order
D& Order = wsdsoap:binding 0% quote
+ " wsdknap:address 8 '® guote Ginpu
@ wsdkoapioperation 4 output
B input: —t
8 4 putput

Messages
T price (xsd:flo

quaniy (xsd:int)
BT quoteResponse
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‘ Agenda

= Consuming

© 2004 Judd Solutions, LLC. Al rights reserved. IIII““ snl“ti““s
‘ Consuming steps
1. Create Java Project
2. Generate Web Service Client
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Create Project

= File > New > Project > Java Project

x|

Create a Java project

Create n Jevn project in th workspats e in an

-J

wxternal locatan, L

Fropect name: | MyGrderient
Contents
@ Create new project n yorkspace
 Create project From exiting source

20K Complisnce

i Use defgult compler compliznce (Cumrently 1.4) Configurs default.,
" Uge a praject specfic compliance: |14+

[ |

Propect loyout

@ Lise preject folder s root for seurces and class s

" Creale separale source and cutput folders Configure defauk,
< ock tets | peisn Cancel
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Generate Web Service Client

« File > New > Other > Web Services > Web

Service Client

x
Web Services !

Rirviiwe your Wb servce options and make any necessary changes 3
before proceeding to the neat page.

Chent proscy
Chent proxy type: |ldw Proxy ;]

[+ Test the Web service

- Heitor the Wieb service

[+ Ovenwrite fies without waming
[ Create loiders when necessary
I Check out fles without warning

< gnck oa>  |[ poen | concat |

& web Service Clent x|

Web Service Selection Page s

Ertier & weh service URL 5

Enter an URI to a WSDL, WSIL or HTML document:
[ nttpzsiee i s/Crdesursa] Browse...
Select a WSDL

2 hitp:/ focalhost BOBD/OrderWs/services, Order fwsdl

< gnck oa>  |[ poen | concat |
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Generate Web Service Client

& web Service Client

Client Environment Configuration

Choas from the list of supported runtimes and servers for the dient
ernaranment, o use the default settings.

Clent-Skle Environment Selection:
Web service runtime: Apache Axe

x|

S

Server: Tomeat v5.0 Server @ localhost

12EE version: 14

|

clent type: [weo =

Clent project: e =l

Cleit module: [ orderws =

Clent EAR project: | =l

Clent EAR module: | =]
< gack o> [ B | canen |

& web Service Client x|

Web Service Proxy Page -
Web Service Proxy Fage é
Output foider [ /Order jorderws/Javasource

[ Define custom mapping for namespace to package.
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Generate Web Service Client

& web Service Client x|

Web Service Client Test

Do you want 1o test the generated proxy? ;

[+ Test the generated proxy

Test facky  [web service sampe J5Ps

18P project: [orc

St forderWS

EAR projects |

Folder: | sampleOrderProsy

18P folder: [ //Order

Methods

[#] geténdpontl)

setEndpont{javaang.String)
[#] gercrdes)

quetefioat int)

ssba] oo

[+ Run test on server

Enieh Cancal
J J
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‘ Using Generate Classes

public static void main(String[] args) throws
RemoteException {

OrderProxy proxy = new OrderProxy();
float quote = proxy.quote(5,5);

System.out._printIn("'Quote is " + quote);
System_out.printIn(C"\nDONE™);
}
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‘ Agenda

e Conclusion
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‘ WTP Resources

e www.eclipse.org/webtools/
e WWW.Projst.com

e Tutorials
— http://www.eclipse.org/webtools/community/co

mmunityresources.htmi#tutorials
« Articles
— http://www.eclipse.org/webtools/community/co

mmunityresources.html#articles
* New Group
— news://news.eclipse.org/eclipse.webtools
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‘ Contact Information

http://www.juddsolutions.com

cjudd@juddsolutions.com

Blog

— http://blogs.apress.com/authors.php?author=Christopher%20Judd

Pro Eclipse JST
— http://www.projst.com
— http://www.apress.com/book/bookDisplay.htm|?blD=447

Enterprise Java Development on a Budget
— http://www.apress.com/book/bookDisplay.htm|?blD=197

Cvmates a1
e e
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Questions ?

Please fill out your evaluations.

Judd Solutions
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